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Introduction 

File Formats 

BeadLogic is a multiplex data analysis program. A range of third-party data 
files, in addition to BeadLogic Bead Export data, can be imported directly into 
BeadLogic. These include: 
 

• Bioplex BPD 
• Bioplex XML 
• CSV (Luminex, etc.) 
• BeadLogic Bead Export 

 

Preferences 

Before beginning an analysis, customize the program by setting the program 
preferences. From the menu bar, select ‘BeadLogic’ (Mac OSX, ⌘,) or ‘Edit’ 
(Windows) and ‘Preferences’. Select various Preference menu options from the 
left hand side of the Preferences window and optimize the settings using the 
options in the window on the right. 
 
Explanations of the different Preference options are as follow: 
 

Layout Tab Defaults 

 
 

 Auto Rename by Default – the auto-rename option forms part of the Sample 
Configuration panel, which is used to define the different types of samples 
in the plate (Standard, Blank, Unknown, Unlabeled and Control). When 
samples are defined as being a Standard, Blank, Unknown, Unlabeled or 
Control, a matching color is assigned and displayed in the Plate Layout. If 
the auto-rename option is selected, the corresponding name, e.g. 
“Standard” will also be added to the well. If the Auto-Number option in the 
Replicates panel is also selected, each sample name will also be numbered, 
e.g. “Standard1”. This Auto-Rename option can be turned on by default by 
selecting the options in the Preferences. 

 Replicate Count – set a default number of replicate wells used for each 
analyte (1-12). 

 Replicate Direction – set the default direction that replicate wells are 
displayed in the plate. 
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o Horizontal: replicates are placed to the right (or on the next row if at 
the end of a row). 

o Vertical: replicates are placed beneath (or in the next column if at the 
end of a column). 

o Natural: wells fill left to right until the defined number of replicates is 
reached. The next series of replicates begins in the row below, even 
if the entire row has not been filled. After filling all of the columns, the 
next sample will be added to the top row in the first available well and 
continue to fill left to right. 

 List (Data) Table Value – set the default statistic to be displayed for each 
analyte in the table located under the List (Data) tab of the Layout section. 
The options are: 

- FI: Median fluorescent intensity 
- Observed: the concentration of an analyte derived from the 

interpolation of the regression curve 
- Observed (Limit): the concentration of an analyte derived from the 

interpolation of the regression curve but with concentrations existing 
above or below the top and bottom standards given the same value 
as that standard (bottom standard for low values and top standard 
for high values). 

- Observed (Removed): the concentration of an analyte derived from 
the interpolation of the regression curve but with concentrations 
existing above or below the top and bottom standards replaced with 
“OOR>” or “OOR<” (outside of range). 

- Bead Count – the bead count is the event count for the particular 
gated population 

 List Table Stat – set default statistics for when replicates exist. A choice 
between a number of statistics derived from the replicate values can be 
displayed. These are:  

- Mean – the mean of the replicate values 
- CV% – the coefficient of variation (displayed as a percentage)  
- SD – the standard deviation 
- Min – the smallest value of all replicates 
- Max – the largest value of all replicates 
- Sum – the sum of all replicate values 

 

Curve Fit Tab Defaults 
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 Default Recovery Range: (10%, 20%, 30%, 40%, 50%, 60% or 70%) – when 
fitting the curve to the standards, the default acceptable recovery range, 
which is the error or the difference between the Observed and the Expected 
values as a percentage of the Expected value, can be set. Standards that 
are within the acceptable recovery range will be colored green on the 
regression tornado graph Standards that are outside of the acceptable 
recovery range will be flagged as a red bar on the same graph. 

 Default Units: e.g. pg/ml – the default units for the concentration, which are 
displayed on the regression curve, can be defined for all new data sets. This 
can be changed for each analyte in the Regression Table window. 

 

Other regression curve display options can be set by default and shown/hidden 
by the right-click menu in the regression curve window. These include: 

 Show Curve – the curve itself 

 Show Calc. Standards – the observed concentration values  

 Show Raw Standards – the expected concentration values  

 Show Unknowns – the unknown or test samples 

 Show Standard Wells – the expected concentration values for all individual 
replicates 

 

Analysis Tab Defaults 

 
 

 Table Value – set the default statistic to be displayed for each analyte in the 
Data Table and defined in all three of the Basic, Intermediate and Advanced 
Table Setup tabs in the Analysis section. The options are: 

- FI: Fluorescent intensity 
- Observed: the concentration of an analyte derived from the 

interpolation of the regression curve 
- Observed (Limit): the concentration of an analyte derived from the 

interpolation of the regression curve but with concentrations existing 
above or below the top and bottom standards given the same value 
as that standard (bottom standard for low values and top standard 
for high values). 

- Observed (Removed): the concentration of an analyte derived from 
the interpolation of the regression curve but with concentrations 
existing above or below the top and bottom standards replaced with 
“OOR>” or “OOR<” (outside of range). 

- Bead Count – the bead count is the event count for the particular 
gated population 
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 Table Stat – set default statistics for when replicates exist. A choice between 
a number of statistics derived from the replicate values can be displayed. 
These are: 

- Mean – the mean of the replicate values 
- CV% – the coefficient of variation (displayed as a percentage) 
- SD – the standard deviation 
- Min – the smallest value of all replicates 
- Max – the largest value of all replicates 
- Sum – the sum of all replicate values 

 
- Default Heatmap: set the default heatmap color scheme. Color schemes are 

displayed as the color corresponding to the low end of value range through 
to the color representing the high end of the value range (in some cases via 
black or white). There is also an option to choose a log color range. This 
option can allow for greater visualization of small differences at the bottom 
end of the data range. The options are: 
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Flag Options 

 
 
 

Flag Point to Point Regression 

 With this option selected, if the regression type is set to Linear (Point to 
Point) in the Regression Table, then the analyte will be marked with a 
yellow square in the Analytes tab in the Layout and Curve Fit sections. 

  

 
 
 
Flag Linear regression 

 With this option selected, if the regression type is set to Linear in the 
Regression Table, then the analyte will be marked with a yellow square 
in the Analytes tab in the Layout and Curve Fit sections. 

  
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Flag bad regression in Plate list 

 If any standard within a dataset in the Files list (in either the Layout or 
Curve Fit tabs) is outside of the Acceptable Recovery Range in the 
Regression Table/Regression Tornado in the Curve Fit section, then the 
dataset file name will be flagged with a red square. If all standards fit in 
the Acceptable Recovery Range, then the dataset will be marked with a 
green square. 

 

 

 

Keywords 

 
 

Keywords and associated values can be added and displayed in the Attributes 
panel in the Layout and Curve Fit sections. These can then be assigned and 
displayed on selected wells in the plate plan. To add a keyword, click the ‘+’ 
button at the bottom of the keywords window. By default, the new keyword will 
be ‘Untitled Keyword’. Double click this text to rename it. To add a value to a 
keyword, highlight the keyword and then click the ‘+’ button below the Values 
window. By default, the new value will be ‘Untitled Value. Double click this text 
to rename it. To remove a Keyword or Value, highlight the text and click the ‘-’ 
button below the relevant window. 
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To add the newly created keywords to samples, right click in the Attributes 

window  Add/Remove Keywords and select the keyword of interest. Then, 
highlight the relevant samples in the plate plan and choose a value associated 
with a particular keyword. The value will then be displayed in the well on the 
plate plan. The follow example uses ‘Gender’ as the keyword with ‘Female’ and 
‘Male’ as the values: 
 

 
 
 
 
 
 

 
 
Keywords and values can also be edited by choosing Edit Keywords form the 
right click menu in the Attributes window. 
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File Import 

 
 

Default automatic analysis settings can be defined and applied to data upon 
importation. These include: 
Default Regression – the regression model used to fit the curve. This can be 
one of the following: 

 
 
Default Layout – A plate layout can be saved and chosen to be loaded by default 
for new analyses. 
 
Default Report – A report layout can be saved and loaded by default for new 
analyses. 
 
Auto Apply Kit – A kit saved to the library can be chosen to be applied 
automatically upon importing data. 
 
CSV Options – CSV files saved in the appropriate format can be imported into 
BeadLogic. Defined columns can be ignored for the process of importing. Add 
or remove the particular columns by way of the column titles. 
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Account 

 
 

Show Tool Tip – information that appears by hovering over certain objects, such 
as the samples in the heatmap or data table in the Analysis section, can be 
turned off. 
 
Auto Release Licence – the licence used to run BeadLogic can be released 
prior to quitting the program for use on another computer. This releasing of the 
licence can be done automatically every time the program is quit. 
 

 

Kit Info 

 
 

Import (or delete) specific kit details. Manufacturer kit information includes the 
list of analytes to be examined and the list of standards used to create the 
curves. 
 
 

Report 
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 Paper Size: set the default paper size for when reports are created. To select 
a specific size, click Set from the Preferences window and then define the 
Page Setup. 

 Default Layout: set elements to be added to the report in a defined grid 
layout or in a free layout. Free layout allows for elements to be placed 
anywhere on the page, even overlapping other elements. 

 Grid Width: input a number to define the grid width 

 Grid height: input a number to define the grid height 

 Snap Size: click on the drop down menu to choose the snap size (1, 2, 4, 8, 
16, 32, 64 or 128). 

  

Main Menus 
The options in the main menu contain general program operational functions. 
Many of these can be implemented using keyboard shortcuts, which are listed 
in the main menus next to the menu items. The four main menu options are: 
 
BeadLogic (Mac OSX) 

 About: this option opens a window displaying the program version along 
with the username, license type and the expiration date.  

 Preferences… : Opens the Preferences window (see page 3 for a full 
description of the program preferences). 

 Quit (⌘Q): select to exit or quite BeadLogic. A prompt window will ask if 
you would like to save the analysis prior to exiting. The options include 
No, Yes or to Cancel the action. 

 
File 

 New (Ctrl+N / ⌘N): creates a new analysis. 

 Open (Ctrl+O / ⌘O): brings up a navigator window allowing the user to 
search for previously saved analyses. After locating and highlighting the 
saved analysis, select Open in the navigator window to load it. 

 Save (Ctrl+S / ⌘S): saves the current analysis. 

 Save As (Ctrl+Shift+S / ⇧⌘S): opens a window allowing the analysis to 

be named and saved in a desired location as a Beadlogic File. 

 Recent: displays a list of recently opened Beadlogic files (.blf). Clicking 
on the name will load that analysis. 

 Import (Ctrl+I / ⌘I): opens a window allowing data files to be imported. 
Only supported file formats can be selected. Select the data file and click 
Open. 

 Recently Imported  : choose from a list of recently imported data files, 
such as .bpd or .flb (FlowLogic/BeadLogic bridge file). These are different 
to the .bfl Beadlogic files, which are saved analyses from within BeadLogic.  

 Exit (Ctrl+Q / ⌘Q): select to exit or quite BeadLogic. A prompt window 
will ask if you would like to save the analysis prior to exiting. The options 
include No, Yes or to Cancel the action. In Mac OSX, the quit option is 
located under the BeadLogic menu option. 
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Edit 

 Undo: undo the last action 

 Redo: redo the last action if it has been undone 

 Undo List: displays a chronological list of actions. Select a specific action 
to undo it. 

 Preferences (Windows only): Opens the Preferences window. In Mac 
OSX, the Preferences are located under the BeadLogic menu (⌘,). 

 
Window  

 Show Window – brings the selected program window to the font of the 
display 

 Library (Ctrl+L / ⌘L) – opens the BeadLogic plate layout library, where 
layouts can be saved, exported and imported. 

 Close All Windows – closes all open windows 
 
License 

 Release: the current license, so that it can be used on another computer 

 Renew: this option allows a new license code to be entered. Choosing 
to renew a license will open a window requesting the user name and the 
License Code. When these have been entered, choose Renew 

 
Help 

 Help F1: selecting help will launch a web browser and open the 
BeadLogic support page containing the BeadLogic manual and supporting 
videos. 

 About (Windows): this option opens a window displaying the program 
version along with the username, license type and the expiration date. In 
Mac OSX, the About option is located under the BeadLogic menu. 

 
 

 

FCS/MQD analysis and plate setup in FlowLogic 
 
Data acquired on a flow cytometer can be analysed in FlowLogic flow cytometry 
analysis software and exported to BeadLogic with all plate setup parameters 
defined. 
Here is a step-by-step description on how to perform this initial part of the 
sample analysis in FlowLogic. For a detailed explanation of the features 
FlowLogic, please consult the FlowLogic manual and video guides available 
online. 
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Importing FCS/MQD files 

 
Files can be imported into FlowLogic by dragging a selection of FCS or MQD 
files directly into the Files Inspector. A folder containing these files can also be 
dragged into the File Navigator. Alternatively, from the main menu choose 

FileImport FCS-MQD-LMD-LXB… or Import Folders and select the files by 
their location. 
 

 
 

OR 
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Grouping files and gating on populations 

 
Creating groups can make analysis of multiple samples very quick and easy. If 
a gate is applied to one file in a group, it is automatically applied to the same 
parameters on all other files in the group. 
 

Select all files to be grouped, right click and select Group  Add to new. 
 

 
 

 
 
 
 



 

 17 

Double click on a file in the File Inspector to open the plot in the Workspace. 
Click on the parameter labels on the plot to change them. Gate on populations 
by selecting the plot in the Workspace, clicking a gating tool from the Toolbar 
and then use the cursor in the plot to define the gate. 
 
 

 
 
After a gate has been created, it will be listed beneath the sample in the File 
Inspector (in this case, R1). The gate name can be changed by right clicking on 
the gate in the File Inspector. To open the subpopulation, double click on the 
population in the File Inspector or double click within the gate on the plot. 
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If the files have been grouped, as in the above Adjustments to individual gates 
are automatically updated to all within the group. If not, highlight the gates in 

the File Inspector, right click and choose CopyCopy Gates. Then, highlight 
the files to which the gates need to be pasted to, right click and choose 

PasteGates. 
 
Continue gating on the specific bead populations that correspond to the 
different analytes. Naming the populations with the analyte name as the gates 
are created makes assessing the results in BeadLogic much easier. As the 
different populations can be relatively close together on the plot, a useful trick 
is to turn a gate off after it has been drawn. This is done by opening the plot 
side drawer by clicking on the button in the lower left of the plot window (or 
double clicking within the plot but not within a gate) and selecting the first tab 
called the Gate List tab. Untick the box in the column titled ‘Show’ to turn the 
gate off. This does not delete the gate, it just hides it from view and makes 
drawing new gates easier. Once all gates have been created, tick all of the 
boxes in the ‘Show’ column to make them visible again. 
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Adding samples to a plate in PlateLogic 

 
After gating and naming the bead populations, add all of the samples to a plate 
in PlateLogic. PlateLogic is located in the Advanced Functions drawer located 
below the Workspace. 
To create a plate, click in the plate window and select ‘New PlateLogic’. To fill 
the plate, highlight a group of files in the File Inspector and drag them into the 
desired well in the plate. It does not matter which gate or level of the gating 
hierarchy is selected and dragged into the plate as only the sample is recorded. 
Once in the plate, the specific subpopulation (gate) can be set and analyzed. 

 

 
 

 

 

 
 
Once all files have been added to the plate, use the functions in the Plate Side 
Drawer to help analyze the samples. Specifically, the BeadLogic Export tab. 
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Plate setup 

 
In the ‘Layout tab’, define each of the samples by highlighting them in the wells 
and clicking on one of the sample type buttons. This will color the background 
of the wells to reflect the different sample types, being Standards, Blanks, 
Unlabeled, Unknown or Controls. 
 
Also, define if technical replicates were used. To do this, choose a replicate 
number for the corresponding sample type. This will result in an average value 
for the replicates being used in BeadLogic. 
 

 
 
 
In the ‘Analyte tab’, choose the analytes to export, set the reporting parameter, 
define the units and name the analyte. These functions can be aided using the 
right click menu.  
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Right click within the ‘Analyte’ window for the following menu options: 
 

 
 

In the ‘Standard’ window, define the expected concentrations for the standards. 
Highlight one standard and type a value in the ‘Expected’ column and right click 
to choose a serial dilution factor in an ascending or descending order, 
depending on which standard you begin with. 
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Once the expected values have been defined for one analyte, right click and 
choose ‘Copy selected’ to copy the settings. Then, highlight other analytes, right 
click and choose ‘Apply to selected’ to paste the same values to the highlighted 
analytes. 

 

 
 
Once all settings have been made, click either ‘Export’ to save a 
FlowLogic/BeadLogic Bridge file (.flb file) or send the analysis directly to 
BeadLogic by clicking ‘Send To BeadLogic’. 
 
The FlowLogic/BeadLogic Bridge file can be imported into BeadLogic at any 
time. In order to send the analysis to BeadLogic, make sure to launch 
BeadLogic before clicking the ‘Send To BeadLogic’ button. 
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BeadLogic - Layout 
After importing new files or loading a saved experiment, BeadLogic will load 
with the following toolbar displayed at the top of the screen: 
 

 
 
To follow a basic workflow, use the functions located under each of the tabs, 
working from left to right, starting with Layout. 
 
When Layout is selected, a range of Plate Setup features is located on the left 
hand side of the screen. Click on each of these to access options to select 
between plates, define the sample configuration (plate layout), define 
replicates, assign attributes to samples, define dilution factors, display the set 
of analytes tested and to view sample metadata. 
 
In most cases, selecting one or more samples from the diagram to the right of 
the Plate Setup section will enable the various plate setup options to be 
accessed and changed.  
 
To view the Plate Layout, select Setup from the sub toolbar under the Layout 
tab. 
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Plate Setup Features 

 

 
 

Files 

 
 
Listed in the Files window is a list of all ‘plate’ files, which have been imported 
into BeadLogic. A green square beside the plate name indicates that 
appropriate standards have been defined in the plate layout. A red square 
indicates that appropriate standards have not been defined in the plate layout. 
 
When a plate is highlighted in this panel, it is considered to be ‘in focus’ and the 
rest of the system will display its related properties and settings. 
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Sample Configuration 

 
 

 
This panel allows for wells to be defined as a standard, blank, unknown, 
unlabeled or a control. One or more wells have to be highlighted in the plate 
layout for the options in this panel to use. 
 
Standard: a well that is used for the calculation of the standard curve. 
Unknown: a well with an ‘Unknown’ value (an experimental sample being 
analyzed). 
 
Control: a ‘Control’ well, such as a high control or low control. These have a 
separate display on standard curves and output tables. 
 
Blank: a well that is used to record background or non-specific readings. The 
values from ‘blank’ wells are subtracted from all fluorescence intensity (FI) 
readings. 
 
Unlabeled: a well that is ignored from all output and reporting. 
 
Stat: select the desired statistic for use in the selected plate. Some file formats 
do not provide any options while others may give a large number of possible 
statistics to choose from. 
 
Auto-Rename: this will allow you to automatically apply replicate settings when 
assigning well types. 
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Replicates 
 

 
 

Direction: allows for the ‘direction’ of replicates to be set. The options are: 

 Horizontal - the next replicate in the series will be to the right of the 
previous one. Once the series of replicates is filled, the next series will 
start to the right of the previous series. When the end of the selection is 
reached horizontally, the allocation will continue from the next row. 

 Vertical - the next replicate in the series will be below the previous. Once 
the series of replicates is filled, the next series will start below the 
previous series. Once the end of selection is reached vertically, the 
allocation will continue from the next column. 

 Natural - the next replicate in the series will be to the right of the previous 
one (horizontal allocation). Once the series of replicates is filled, the next 
series of will start below the previous one until the end of the selection 
is reached vertically. The setting will then continue from the next column 
and allocate the wells horizontally. 

 

Replicates: this drop-down menu allows you to set the number of replicates in 
a given series. 
 
Sample Name: this text field allows you to set the ‘sample name prefix’ for wells 
prior to replication. A number is appended to the name to signal, which wells 
belong to which series. 
 
Auto-Number – if the name and replicate number is defined for a selection of 
wells, the auto-number feature will append each name with a number in 
ascending order. 
 
Clear All: resets all wells in the current plate, renaming them with their well ID. 
 
Clear: resets all selected wells, renaming them with their well ID. 
 
Apply: applies the settings to the selected wells. 
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Attributes 
 

 
 

This window provides a list of ‘attributes’ or keywords for highlighted wells. A 
drop-down box populated with ‘*’ indicates that the selected wells have different 
values for the given attributes.  
 
Right click within this window to access options to add or remove keywords 
from the current plate as well as edit the global attributes list. 
 

 

 

Dilution 
 

 
 

This panel can be used to apply dilution factors to wells. If dilution factors have 
been applied, BeadLogic can signal if there is a difference in dilution between 
different wells. Dilution factors are also used in conjunction with the Curve Fit 
section (accessed in the main toolbar) to define serial dilutions of standards 
without having to define expected values manually. 
 
Dilutions can be defined using the features under either the Basic or Advanced 
tabs. 
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 Basic: 

 Peak: the ‘Initial’ or ‘Neat’ concentration. 

 Dilution: the serial dilution ratio of subsequent wells. 
Advanced: 

 y[0]: the ‘Initial’ or ‘Neat’ concentration. 

 y[n+1]: an area where an equation can be entered for the 
calculation of the next value in the dilution series. 

 
Apply: when clicked, the Basic or Advanced settings will auto-populate the 
selected wells with the appropriate dilutions. 
 
Dilution Table: a table where dilutions can be both viewed and manually entered 
on a sample-by-sample basis. 
 
 

Analytes 
 

 
 

The analytes being analysed are displayed in this window. A green square next 
to the analytes indicates that all of the standards for that analytes fit within a 
defined acceptable error range. A red square indicates that at least one 
standard falls outside of the defined acceptable error range. To automatically fit 
the curves to the data, right click on an analyte and select Auto-Fit. 
Kit Info files, containing all of the analyte information, can be imported into 
BeadLogic by clicking Edit-> Preferences -> Kit Info -> Import. 
 
Kit Info files can be applied to a plate from the Analytes tab in the Plate Setup 
section. 
 
If Automatic Kit Info is enabled in Preferences, the first available Kit Info will be 
preloaded. 
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Metadata 
 

 
 

The metadata window displays all of metadata associated with an imported file. 
Metadata can be exported by right clicking in the metadata window and 
choosing Export Table. Choose to export the metadata as either a CSV or an 
Excel XML Workbooks file. Note: some file formats do not provide metadata. 
 

Library 
 

 
  
Click this button, located at the bottom of the Plate Setup window, to import and 
export all settings created in the Layout tab. 
 
To save a template of the current template, select Save from the bottom of the 
window. This will open another window with options to name the template, 
name the author and define which template parameters to save with the file. 
Once the template has been created, click to highlight it and choose export to 
save it as a ‘Bead Plate Setup Template’ (.blpst file). This can be imported in 
subsequent analyses 
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 Import: import a library item that has been saved externally. 

 Export: export of a library item as an external file. 

 Delete: deletes the currently selected library item from the library 

 Save: saves the current plate layout into the library with the ability to 
select which items are saved in the template. 

 Template Name: the human readable name for the template you wish to 
save 

 Template Author: the author of the template 

 Well Type: if enabled then the well types for the currently selected plate 
will be saved (e.g. Standard, Unknown, Control, Blank, Unlabeled) 

 Sample Name: if enabled then the sample names (replicate definitions) 
are saved 

 Dilution: if enabled then the dilution information will be saved. 

 Keywords: if enabled then the Keywords and their values will be saved. 

 Statistic: if enabled then the statistic definition for the plate will be saved. 

 Ok: if clicked the Save process will be completed. 

 Cancel: if clicked the save process will be aborted. 

 Apply: will apply the currently selected library item to the current plate. A 
dialog box will allow unwanted items to be turned off/excluded from the 
template. (The definition and meanings of the items is the same as in the 
‘Save’ dialog) 

 Close: causes the Plate Layout Library to disappear. 
 
From the plate Setup tab you can highlight wells and apply the settings from 
the menus from the left and side. 
 
Right click in the plate layout and choose ‘Discontinuous Selection’ to make a 
selection of wells from across the plate (not just connected horizontally or 
vertically. 
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List (Data) 

 
 
The List (Data) tab provides a table display of the current data. To export the 
data, right click within the table and select Export Table. 
 
Above the table are a number of table format settings. These are: 

 Table Value: select the type of value to be displayed in the table for the 
current plate 

 FI (Fluorescence Intensity): when selected the statistic for the 
table is the raw fluorescence intensity. 

 Observed: this is the observed (regressed) value without any 
markings whether the value is OOR or not 

 Observed (limit): this is the observed value, although if a value is 
considered to be OOR, it will be limited to the relevant upper or 
lower limit of quantization. 

 Observed (removed): this is the observed value but when it is 
considered OOR, it will be marked OOR> or OOR< appropriately. 

 Bead count: this is the recorded bead count for the sample. Note: 
some file formats do not provide bead count data. 

 

 Table Statistic: the aggregate statistic for the replicates used for the table. 

 Mean: the mean of all the selected ‘Table Values’ for the 
appropriate sample. 

 CV%: the Coefficient of Variation of the selected ‘Table Values’ for 
each sample. 

 SD: the Standard Deviation of the selected ‘Table Values’ for each 
sample. 

 Min: the minimum value of the selected ‘Table Values’ for each 
sample. 

 Max: the maximum value of the selected ‘Table Values’ for each 
sample. 

 Sum: the sum of the ‘Table Values’ for each selected sample. 
 

 Highlight OOR: if enabled then the ‘Out of Range’ samples will be 
highlighted in red. 

 

 Background Color: provides the rules for the background color of the given 
wells. 

 No Background: If selected then there is no background color 
coloring 

 CV FI: if selected then the cell background will be colored yellow 
when the CV of the fluorescence intensity is outside the threshold 

 CV Obs: if selected then the cell background is colored yellow 
when the CV of the observed values of the given cells is outside 
of the threshold 

 CV% Thresh: The threshold that is applied to the background color settings. 
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List (Attributes) 

 
 

 
The List (Attributes) tab provides a list of all samples and the 
Attributes/Keywords that have been applied to them. Right click to export the 
entire table or to apply keywords to selected samples. 
 

 
 
 

List (Well Data) 

 
 
The List (Well Data) provides a quick view of all the raw data in the table not 
separated by sample. 
 
 

Curve Fit 

 
 
In the Curve Fit tab, curve-fitting functions can be performed manually or 
automatically. Manual adjustments (enabling and disabling standards) are 
performed individually, on a per analyte basis. 
 
Within the Curve Fit tab there are five windows. On the left hand side are the 
Files and Analytes windows and in the workspace on the right hand side are 
the Regression Curve, Regression Tornado and Regression Table windows. 
Click on the window headings to expand and collapse them. 
 
Files 
See Layout → Files for a more detailed explanation. 
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Analytes 
 
 

 
 

 
The analytes in the current plate are displayed in this window. When an analyte 
is selected within this window the output in the Regression Curve, Regression 
Tornado and Regression Table windows will update to display the result for the 
specific analyte. 
 
A red square next to the analyte name signals that it has at least one standard 
with an error outside of the acceptable recovery range. If a given plate provides 
‘bead Id’ information, this can be used to apply a compatible kit info to the plate, 
which will pre-fill expected concentrations of standards. 
 
The right click menu is as follows: 

 Import Kit Info: import a new kit info file into the preferences. 

 Copy Regression to All: copy the Acceptable Recovery Range and 
regression settings and apply it to all analytes in the plate. 

 Auto-Fit: runs the ‘Auto-Fit’ algorithm for all analytes in the plate. The results 
can then be checked visually. This algorithm progressively disables 
standards at the upper and lower limits of the range until all standards sit 
within the acceptable recovery range. 

 Send all to report: sends all analytes to an ‘analyte only report template’. 
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Regression Curve 
 

 
 
The Regression Curve window displays the standard regression curve. There 
is one ‘Log → Lin’ button on each axis to allow for the switching of axis 
transformations. This display is configurable from the right click menu: 
 

 Show regression Curve: enables/disables the regression curve from the 
display. 

 Show Calculated Standards: enables/disables the ‘calculated’ standard 
values. 

 Show Raw Standards: enables/disables the ‘Raw’ standard values (non-
regressed). 

 Show Unknowns: enables/disables display of unknowns on the curve 

 Show Standard Wells: enables/disables the actual ‘wells’ that make up each 
standard sample. All wells are included in the calculation for a quick visual 
display of CV within a standard sample. 

 Show Controls: enables/disables the display of controls from the standard 
curve. 

 Show Legend: enables/disables the display of the Legend on the regression 
curve display. 

 Axis Font: allows the axis label font to be changed. 

 Number Font: allows the numeric axis label font to be changed. 

 Legend Font: allows legend font to be changed. 

 Title Font: allows regression plot title font to be changed. 

 Show Legend Outside of Plot: allows the location of the legend to be 
changed: 

  outer right hand side of the plot area 

  top left hand side inside the plot 
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 Regressed Standard Size: allows the size of the 'dots' for the regressed 
standards to be changed. 

 Standard Size: allows the size of the 'dots' for the raw-standards to be 
changed. 

 Unknown Size: allows the size of the 'dots' for the unknowns to be changed. 

 Control Size: allows the size of the 'dots' for the controls to be changed. 

 Show All: displays all plot items for the standard curve. 

 Export: export the standard curve in one of a number of external file formats: 
 

 

 
 
 
Regression Tornado 

 

 
 
 
The Regression Tornado window provides a simple display to view the 
difference between expected and actual values for the standards. 
 
The plot is configurable via the right click menu: 

 Background: change the background color for the plot. 

 Enabled Foreground: set the foreground color for a standard that is both 
enabled and within the acceptable recovery range. 

 Disabled Foreground: change the foreground color for a standard that has 
been disabled. 

 Out of Range foreground: set the foreground color for a standard that is both 
enabled and out of range. 

 Draw Text: if enabled, text appears on the inside of the tornado plot. 

 Plot Font: change the font inside the plot. 

 Title Font: change the font for the title (axis). 
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Regression Table 
 

 
 
Within the Regression Table, standards can be enabled and disabled. The 
manual entry of expected concentrations can also be performed in this window. 
 
Right click to display options to configure the table: 
 

 
 
 

 

 Serial Dilution (Descending and Ascending): allows for the setting of 
expected concentrations via a serial dilution (starting at the value of 
Standard 1). 

 Manual Dilution: set the defined dilution factor using the format: *x (where x 
is the dilution factor) 

 Copy Expected: once the dilution factor has been defined, the settings 
determining the Expected Values can be copied from one analyte and 
pasted into the Regression Table of other analytes. 

 Paste Expected: this option becomes available after copying the dilution 
settings from one analyte. This option allows the settings to be pasted into 
the Regression Table of other analytes. 

 Clear Concentrations: clears all concentration settings in the Expected 
column. 
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 Wells: displays the well ID and FI for an individual sample. 

 Calculate best fit: performs the best fit algorithm for the standards. 

 Apply Expected Values to All: this applies the Expected values from one 
analyte to all others in the analysis. 

 Export Table: export the table as either a CSV file or an Excel XML 
Workbooks file. 

 Table Setup: define the number of decimal places and the text font used in 
the table. 

 Print: allows for the printing of the Regression Table. 
 

Within the Regression Table panel are settings to define the Acceptable 
Recovery Range, Regression type and the concentration units. These are as 
follow: 
 
 

 
 
 

 

 Acceptable Recovery Range: the percentage for which a given standard’s 
expected value can fall in based on the regressed value. 

 Regression: use to set the current regression type. The options are: 

 Linear 

 Linear (Point to Point) 

 4-PL Fit 

 5-PL Fit 

 Cubic Polynomial 

 Units: the units to be displayed in reports and tables for a given analyte 

 Uloq and Lloq: the upper and lower limits of quantification. These values 
represent the highest and lowest fluorescence intensity values from the 
standards. 

 
Library 
 
Click this button to import and export all settings created in the Layout tab. See 
page 29 for more details. 
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Analysis 
 

 
 

 
The core of the analysis area is data mining and preparation for statistical 
analysis and reporting. 
 
Tables  
 

 
 

 
This is the primary list of tables, which are used for data mining and analysis. 
When a plate is imported a table is automatically created but a table should not 
be mistaken for a plate. Tables can contain the data from many plates. Rename 
a table by double clicking on its name and typing the new name. 
 
A right click within the table window brings up a menu with the following 
features: 

 New Table: creates a new table from a plate containing data. 

 Clone: creates an identical copy of the highlighted table. 

 Data: allows data from individual plates to be enabled/disabled.  

 Delete Table: deletes the highlighted table. 
 
Table Setup  
 

 
 
 
Three levels of control are available for data mining: Basic, Intermediate and 
Advanced. 
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Basic 
 

 
 

 
 
 
This is the simplest form of table generation. It does not provide any mining or 
aggregation tools, although it does make it simple to quickly produce a table of 
results. There is a number of buttons that enable/disable columns and rows in 
the data table. These are located in different subsections. 
 

 Value 

 FL: displays the Fluorescence Intensity columns in the table for each 
analyte. 

 Observed: displays the Observed value columns for each analyte. 

 Observed (Limit): displays the Observed (Limit) columns for each 
analyte. 

 In Range: displays the In Range columns for each analyte. 

 Bead Count: displays the Bead Count columns for each analyte. 
 

 Fields 

 Show Standard: displays all rows that where wells have been marked as 
standards. 

 Show Blanks: displays all rows where wells have been marked as 
blanks. 

 Show Controls: displays all the rows where samples have been marked 
as controls. 

 Show Unknowns: displays all rows where wells have been marked as 
unknowns. 

 Show Keywords: displays all the ‘Text’ columns for a given table. 

 Stat 

 Mean: displays the mean of the replicates for each displayed column.  

 CV %: displays the coefficient of variation between replicates for each 
displayed column. 

 Std. Dev.: displays the standard deviation between replicates for each 
displayed column.  

 Min: displays the minimum value of the replicates for each sample for 
the displayed columns. 

 Max: displays the maximum value of the replicates for each sample for 
the displayed columns. 
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 Sum: displays the sum of replicate values for each given sample for the 
displayed columns. 

 

 Sample Label: choose between displaying the sample name or other 
sample descriptions as defined in the Attributes panel of the Layout tab, 
through the right-click menu and the Add/Remove Keywords option. 

 
 

Intermediate 
 

 
 
The intermediate table setup allows for both data aggregation as well as data 
filtering and grouping. The features contained within the Intermediate window 
include: 
 

 Group By: creates an initial level of grouping. Once a column is selected as 
available for grouping, all of the rows will be ‘merged’ with the selected 
aggregation statistic. 

 

 
 Then By: provides the second and third levels of grouping. 

 Split Groups: when enabled, the sorting is kept but the groups are split back 
into their samples. This can be useful for a quick view of the source data 
without having to modify grouping settings. 

 Statistic: allows for the selection of the aggregation statistic for grouped 
data. 

 Table Value: allows for the selection of the source statistic for each sample. 

 Statistic Value: allows for the selection of the statistic calculation used to 
generate a single sample value. 

 Sample Label: allows the Value in the ‘sample’ column to be changed. 

 Visible (column): allows data columns to be made visible/invisible. 

 Sample Filter: Click on ‘Sample’ under ‘Column’ in the table to view the 
entire sample list to the right. Make a selection using the check boxes in the 
‘Included’ column, or by using the buttons below the panel, and click apply. 
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The resulting sample list and statistics will be displayed in the Data Table 
below the Table Setup window. 

 

 
 
 

 Numeric Filter: use the numeric filter to remove rows that do not meet certain 
criteria. The numeric filter will appear when a row is selected in the table. 

  

 
 
 

 List table: once the setup is complete, click the ‘Apply’ button to apply the 
filter. There are a number of filter options available. 

 None: no filtering is performed. 

 Equals A: when a value from the given column matches the value 
entered in the text box for ‘A’ it will be included in the output. 

 Not Equals A: when a value from the given column does not match 
the value entered in the text box for ‘A’ it will be included in the output. 

 Less than A: when the value for the given column is less than A it will 
be included in the output. 

 Greater than A: when the value for the given column is greater than 
A it will be included in the output. 

 Less than or Equal to A: when the value for the given column is less 
than or equal to A it will be included in the output. 

 Greater than or equal to A: when the value for the given column is 
greater than or equal to A it will be included in the output. 
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Advanced 
 

 
 
The advanced table setup is similar to the intermediate table with the exception 
of having a full grouping window where the grouping level of any given analyte 
can be set from the main editor. 
 
 
Data Table 
 

 
 
Right click in the table and select from the options to Export the data, define the 
number of decimal places, change the font and print. 
 
By clicking on the table column headers you can sort the rows by a given 
column's values in either ascending or descending order. 
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Quick Heatmap  
 

 
 
 
 

 
 

 
The quick heatmap has all of the basic functionality of the ‘Data Table’. Each 
column’s values are separate in regards to the heatmap calculation and 
therefore the color, which is defined as the ‘maximum’ for that particular statistic. 
The heatmap is updated as the selections made in the Table Setup tab are 
changed. 
 
Color Scheme: this drop down box different color options for the heatmap. The 
different color options are: 
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Statistics 
 

 
 
Within the Statistics tab, values displayed in the Data Table of the Analysis tab 
can be graphed and analyzed. 
 
Bead Data: located to the left of the worksheets, the Bead Data window 
contains a list of all the 'tables' that have been built in the Analysis section. A 
default graph and analysis is created for each table. Double click the graph 
name to open it in the workspace above the worksheet. Right click on the graph 
name for options to rename it (along with adding a new experiment, opening a 
graph in the graph workspace and deleted the highlighted row. 

 

 
 

 
Data: the data section allows for mathematical manipulation and concatenation 
of data tables. 
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Graphing data 

 
Display all of the relevant data in the Data Table of the Analysis tab and choose 
the specific samples that you wish to be included in a graph. Note that the 
different values and specific analytes can be chosen in the Statistics tab but the 
selections of samples cannot. 
 
Once all desired data and the correct samples selection has been performed, 
return to the Statistics section. Choose the specific plate in the Bead Data 
window and the same data displayed in the Data Table will be displayed in the 
data window to the right. 
 
Select populations from the drop down menus for the Primary Group and the 
Analyte. The table will automatically update to show the defined data. To open 

a graph for the defined data, double click or right click  Open Graph the 
‘Graph’ tab in the Bead Data tab. The graph will be displayed in the graph 
workspace above the data tables. 
 

 

 
Right click on each axis of the resulting graph to display options to set the font 
type, color and alignment, define the number of decimal places and change the 
angle of the text. 
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Right click within the graph area to display a different menu with options to 
change the color of individual samples, the background color, turn the graph 
border on or off, set the border color and export the graph. 

 

 
 
Each graph has a side drawer containing a range of formatting options. This 
can be opened by clicking on the double arrows at the bottom right of the graph. 
 

 
 

The side drawer is divided into five tabs: Graph Settings, Graph Axis Settings, 
Graph Color Settings, Graph Legend Settings and Graph Border and 
Background. 
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Graph Settings 
 

 
 

From the drop down menu, choose from different graph types: 

 
 
Different graph formatting options will appear in the window depending the type 
of graph chosen.  

Graph types: 
 
Pie Graph 
 

 
 

 Output Value: allows for the selection of the statistic, which determines 
the output value of each slice. 

 Group Slice: turns the pie graph into a ringed pie graph. 

 Draw Border: enables/disables the border of each ring. 

 Labels: allows the Selection of ‘None’, ‘Percentage’, ‘Value’ or ‘Name’ as 
the labels for each slice. 
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 Label Color: allows the color of the labels to be changed 

 Label font: allows the font of the labels to be changed. 
 
Group Bar Graph 

 A bar graph that shows individual values without statistical manipulation. 

 Interleaved: if enabled, each group column is interleaved with the others.  

 Draw Border: enables/disables the border around each column 

 Border Color: allows the color of the column border to be changed. 

 Gap: define the gap between columns. 

 Group Gap: define the gap between groups. 

 Gap Alignment: allows groups of columns to be justified in different parts 
on the x-axis. 

 
Bar Graph 
 

 
 

 

 Includes statistical manipulation on values within groups to provide each 
portion of the bar. This Graph type can also be used to create box and 
whisker plots. 

 Bar Height: allows the height of each column to be defined based on a 
statistic for a given group 

 Error Bar 1: allows the position of one of the error bars to be defined 
based on a statistic for a given group 

 Error Bar 2: allows the position of the other error bars to be defined 
based on a different statistic for a given group 

 Bar Style: allows for the manipulation of how the error bars are drawn 

 Bottom: allows for the location of the 'bottom' of the bar to be set. 

 Stacked Bar Graph: the stacked bar graph shows multiple bars either 
stacked or overlapped 

 Superimposed: when enabled the bars are overlapped. Otherwise, they 
are stacked on top of each other. 

 Gap: allows for the setting of a 'gap' between bars. 

 Alignment: the alignment of the bars on the X axis. 

 Dot/Line 

 Draw Lines: if enabled, lines are drawn 
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 Draw Points: if enabled, points are drawn instead of lines. 

 Regression Plot 

 Histogram 

 Column Scatter 
 

Graph Axis Settings 
 

 
 

Various formatting options for the x and y axes are available in the Graph Axis 
Settings tab. These are divided into the categories of General, Labels, Scale, 
Major Tick Lines and Minor Tick Lines. 
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Graph Color Settings 
 

 
 

Click on the Fill color associated with a particular sample to choose a new color. 
 

Graph Legend Settings 
 

 
 

Format various elements related to the graph legend. 
 
 

Graph Border and Background 
 

 
 

Choose a color for the border and graph background. Choose to display or hide 
the border. 
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Statistical Analysis 

To perform a statistical analysis on data contained in a graph, in the Statistics 
section click ‘Analysis’ associated with the particular graph in the Bead Data 
window. This displays the available statistical tests and the list of samples to 
compare in the ‘Analysis’ window.  
 
To perform a statistical test, choose an Analysis Group along with an Analysis 
Type from the drop down menus. 
 

 
 

Select the groups that you wish to compare and click ‘Apply’. The result will be 
displayed in the Description and Analysis columns adjacent. 
 
 

 
 
 

The options with the Analysis Group are: 
• t tests (Parametric and non-Parametric) 
• One-way ANOVA (Parametric and non-Parametric) 
 
For t tests, the options with the Analysis Type are: 
• Unpaired t tests with Welch-Satterthwaite approximation 
• Unpaired t tests 
• Unpaired t test Equal Variance 
• Paired t tests 
• Mann-Whitney 
  



 

 52 

For One-way ANOVA, the options with the Analysis Type are: 
• One-way analysis of Variance 
• Kruskal-Wallis test 

 
Another option for graphing data is in the Graph Modify Data Window. This can 
be accessed by selecting a Worksheet in the Data window (next to the tab for 
the Bead Data window. 
 

 
 
This is where calculations involving group data (as displayed in the Graph Data 
Worksheets) can be performed. For example, proportions of one group (or 
individual samples) can be compared to another, with the result automatically 
converted into a new graph. 
 
For example, the percentage that Group 1 is of Group 2 can be calculated as 
follows: 
 

 
 
Enter a number in the Value 3 field and click ‘Apply’. 
 
 
By default, the first graph in the Graph Data window is titled ‘Graph 1’ and the 
first Graph in the Graph Modify Data window is ‘Graph 2’. This is why when 
adding a new graph to the Graph Data window it appears as ‘Graph 3’. Names 
of all graphs, analyses, worksheets and experiments can be renamed by 
clicking on the title when it is selected. 
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Report 
 
Reports can be generated, containing any of the elements created as part of 
the data analysis. 
 

 
 
 
These elements along with various formatting options can be selected from the 
panels below the tabs to the left of the page layout. These tabs are: 
 

 
 

To add an element, click and drag it from the panel directly onto the page.  
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Reports can be annotated and edited using the elements in the toolbar at the 
top of the screen. These include: 
 

 
 

 
Layout and library templates: To create a layout template, click the template 
button in the toolbar and press ‘Save’. This allows the user to save a basic 
report template including headers and footers. Data is then added to the report 
manually. To save a Library Template, create a report including all data 
(graphs, tables, heatmaps, etc.). Then, click Library at the bottom of the screen 
and click ‘Save’. Enter the library name and description and click ‘Ok’. To load 
a Library Template, select ‘Library’, choose a library and click ‘Apply’. This will 
load the library template and repopulate all the data-associated elements with 
the results from the new analysis. 
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Click through the tabs above the File Inspector to customize and manage your 
document. 
 
 
A default report showing all regression curves can be generated by right clicking 
on an analyte in the Analytes panel in the Curve Fit tab and selecting ‘Send all 

to report’  ‘Default Analyte Report’. 
 
 

 


